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ICIS Records Management System

ICIS RECORDS MANAGEMENT

LOGGING ONTO THE SYSTEM

Use the mouse to click on the START menu button in the lower left of the screen. This will
display a list of functions. Access PROGRAM FILES and a secondary list will be displayed.
Move the mouse to PSSI and from there to ICIS. Click on ICIS and the program will begin. If
your System Administrator created a shortcut, simply double-click the icon ICIS V2.3 listed
on the screen. Either procedure will display the INCIDENT CRIME INFORMATION SYSTEM
screen, as shown below. From this screen you will log onto the records system.

R T =

incident Crime Information Systermn

PSSi’
S = |

Oficer ID Agency
al

fss: Il

.

To log on, enter your Officer ID, Agency, and Password. All of these fields are required.

Officer ID: This is your assigned user id.
Agency: This is your agency's unique identifier.
Password: This is your assigned password. As you type your password,

each character is replaced with an asterisk. Your password is
a means of protecting your User-Id and should remain
confidential. :

PSSI



ICIS Records Management System

Complete all of the fields and press the Enter key. The display of the ICIS MAIN MENU, as
shown below, indicates you have properly logged on. Should an invalid officer id or
password combination be entered, the system will display an error message. After three
consecutive unsuccessful attempts, ICIS will terminate.
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The ICIS system utilizes basic windows features, including a title bar and drop-down menus,
accessed by pointing and clicking with the mouse or using the keyboard. To use the
keyboard, press the ALT key with the appropriate underiined 'hot key'. The up and down
arrow key may also be used to highlight an option from the drop-down menu. Once
highlighted, press the Enter key to perform the function.

The drop-down menu options include File, Config, and Help. The File drop-down menu
option allows access to the Print Screen and Exit functions. The Config menu is used to
change Colors, Change Password/Authword, and Maximize Screen.

The Help menu displays useful information about the ICIS software. In addition to providing
version number and database information.
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Logging Off

Several options are available to log off the system. The quickest is to use the EXIT option
from the Toolbar. A confirmation message is displayed to verify the exit function. |f
accepted, the ICIS program is terminated. The other methods involve using the Exit button
from the lower right of any accessed module until you are returned to the Log-On screen.
From here, select File from the drop-down menu and then select Exit. A confirmation
message is displayed to verify the exit function. This method will log off the current user and
return the Logon Screen. The last method is using the 'X' button in the far upper right corner
of the ICIS window. This is Windows method of exiting and will terminate the ICIS program.
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WORKING AT THE TERMINAL

While the data requirements vary from site-to-site and from one module to the next, the basic
rules for data entry are the same throughout ICIS. Each ICIS module has a title bar stating
the name of the module. Below the title bar is a menu bar containing a set of menu options.

To display any of these menus, use either the mouse or the keyboard.
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Drop-Down Menus

Drop-down menu options are located directly below the title bar in each ICIS module. The
‘drop down’ menus are accessed by using the mouse to point and click on the menu name or
by using the keyboard and pressing the ‘Alt' key and the underlined ‘hot' key in combination.

The following is a list of drop down menu options currently available within the ICIS system:

File
The File option offers different abilities dependent upon which module you are
accessing as well as where in the accessing level you currently are. The options
will be discussed within each respective module.

List

The List option is used to redisplay the list of candidates. This menu option is
activated and available only after a list of candidates has been returned via a
search. In addition, the List of Candidates offers the user the ability to change the
sorting of the existing data. By simply moving the reporting officer column to the
beginning of the form, your List of Candidates can now be sorted by officer. To
perform this process, point your mouse onto the desired column header and while
holding down the mouse button, move the column to the desired location. Once
you release the mouse button, the column should now be in its new position
within the form.

A new configuration feature has been added that allows the user to define the List
of Candidates columns for various modules throughout the ICIS system. When
initially setting up ICIS, the Systems Administrator can now configure the List of
Candidates for each module inciuding the selecting of all fields or a subset of
fields. This new feature is accessed from the List of Candidates Setup option
under the Administrative Menu.

In addition, a new pin-mapping feature has been added that allows the user to
map either all of the list of candidates or a selection from the list onto a map. This
feature is beneficial in allowing the user to visually see where the majority of
crimes occur within their agency. This feature is availabie to customers who have
mapping and lat/longs within their Geobase.

Clear List
The Clear List option is used to clear the list of candidates. This menu option is
activated and available only after a list of candidates has been returned via a
search.  Choosing this menu option will disable the List and Clear List menu
options until another list of candidates is returned. Keep in mind that the list
doesn't have to be clear before processing a new search. A new search will
simply overwrite the existing list of candidates with the new list of candidates.

Range Search
The Range Search option is used to perform range searches, which generally
include dates, times, and/or incident numbers. The Range Search option can
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also be used in conjunction with fields from the module to perform a more specific
type of search.

Options
The Options menu offers different abilities dependent upon which module you
are accessing as well as where in the accessing level you currently are. See
each respective module for details on the options available.

Help
The Help menu displays useful information about ICIS, including the version
number of the program and the database.

ICIS Organization

The use of tabs as an organizational tool is consistent throughout the ICIS Records
Management System. Each module contains tabs designed to fit the needs of the specific
module. The tabs are numbered and display a text description of the general contents of
each folder. To move from one folder to the next use the mouse to point and click on the
desired tab. The keyboard may also be used to access a specific tab by pressing and
holding the ‘Alt’ key and then pressing the underlined ‘hot' key. The tabs use the underlined
numeric value as the ‘hot’ key.

Each tabbed section is its own form and these forms are made up of fields for data entry.
Some fields are self-explanatory and then there are some that seem cryptic. If a field is
unfamiliar, a data dictionary has been provided at the end of this document defining each
field.

Function Buttons

At the bottom of the screen are function buttons used to perform various tasks. The following
are brief descriptions of the function buttons available in each module.

Add Function Button
The Add button is used to create a new report once available data has been
entered in the data fields. As we have seen, all modules have numerous
tabbed sections. It is not necessary to use the Add button after each tab, but
simply when the entire report has been completed. Once processed, the
system will display a message stating the record has been added.

Update Function Button
The Update function allows the user to add, change, or delete information in
an individual record. A record must be retrieved before it can be updated.
Once processed, the system will display a message stating the record has
been updated. If no changes were made, a warning message will be
displayed.

Delete Function Button
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The Delete function allows the user to delete a record from the system. This
is based on the user's security clearance. A record must be retrieved before it
can be deleted. Once processed, 2 message box is displayed confirming the
deletion of the current record. Use the Yes button to delete the record. Use
the No button to abort the deletion process. Upon confirmation of the
deletion, the record is deleted and the system displays a message.

Clear Function Button
The Clear button is used to clear the data from all fields on all tabs. This
feature can be used after a record has been retrieved and displayed, to
remove search criteria or to remove all data from a partially completed report.
This function will clear the screen, but will not add, delete or update a report.

Exit Function Button
The Exit button is used to exit the current level of operation and return to the
Main Menu. If any data has been entered or the value of any field changed, a
message will be displayed. Remember to process an Add or Update prior to
exiting. Use the Yes button to exit from the module without saving. Use the
No button to remain in the module and keep the screen intact.

x-Return Function Button

The x-Return button replaces the Exit button when accessing linked modules.
Use the x-Return button to exit the current linked module and return to the
original report {usually Offense, Case Management, Booking, Traffic Accident,
or Municipal Court). If any data has been entered or the value of any field
changed, a message will be displayed. Remember to process an Add or
Update prior to exiting. Use the Yes buiton to exit from the linked maodule
without saving. Use the No button to remain in the linked module and keep
the screen intact.

Search Function Button
The Search button is used to retrieve one or more records from the database.
Enter data in one or more fields, or ieave the fields blank, and use the Search
button. If one record is retrieved, it will be displayed on the screen. If more
than one record matches the criteria, a list of candidates will be created from
which the user may select which record(s) to view.

Searches can also be done with a wild card. Wild cards allow searching on
portions of data instead of the entire word or groups of words. The ‘wild card’
search character used in the ICIS system is the percent sign (%). Entered
before a text string, the search will retrieve all records ending with the selected
string. Entered after a text string, the search will retrieve all records beginning
with the selected string. Entered before and after a text string, the search will
retrieve all records containing the selected string within the searched field.

Example:
%98 retrieves all records ending with “88", for example “126398"

98% retrieves all records beginning with “98", for example “984563"
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%98% retrieves all records containing “98" (i.e. “126398", “084563" &

“679852")
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Special Data Fields

On-line Help

Throughout every module in ICIS, an on-line help feature can be accessed by
pressing the F1 function key when the cursor is within a field. This method will take
the user directly to that portion of text where the user is requesting assistance.

Coded

The ICIS records management system utilizes coded fields that allow the user to
define specific codes to aid in consistent, uniform data entry throughout the system.
The coded fields are recognized throughout ICIS by the appearance of a light 3-D
border along the lower and right margins of the text box. Data entered in these fields
must match the information defined in the code tables. To view the defined codes for
any coded data field, position the cursor to the field in question and double click the
left mouse button or press the F2 function key. This procedure will display the codes
and their corresponding descriptions.
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To choose a code from the list, highlight the selected code and double click the left
mouse button or press the ENTER key. To go to a specific point in the list, enter the
first one or two characters in the code before double clicking or pressing the F2
function key. Once the list is displayed, entering a character will position the cursor at
the first code beginning with that character. Entering the same character again will
“‘walk” the user through the list of codes beginning with that character.

The operator can also determine how coded fields are sorted. In the example above,

there are two columns within the coded field table.
information being sorted by the offense number in ascending order.

This example shows the
To sort in

descending order, simply right click with the mouse. To return to ascending order,
simply right click with the mouse. To sort using the other column, first highlight an
item in the right column and then right click with the mouse. To return to the first
column, highlight an item within the desired column and right click.

Date

All date fields in ICIS are in MMDDYYYY format, where MM is the 2-digit month, DD
is the 2-digit day of the month and YYYY is the 4-digit year. For standard dates, if a
2-digit year is entered, the system will place “19” in front of the year if the year is
between 50 and 99 or “20” in front of the year if the year is between 00 and 49. For
date-of-birth dates, the system will place "20" in front of the year if the year is
between 00 and the current year, and "19" for all other years. Other shortcuts to date
entry are performed by typing in the following characters in the date field:

T = Current Date
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Y = Yesterday's Date
M = Tomorrow's Date

T+{number) = Displays designated number of days into the future
T-(number) = Displays designated number of days into the past
(4-digit numbers are the maximum allowable)

Time

All time fieids in ICIS are in HHMM format, where HH is the 2-digit hour and MM is the
2-digit minute. Times are expressed in military format, with the hours between 00 and
23 and the minutes between 00 and 59. Other shortcuts to time entry are performed
by typing in the following characters into the time field:

N = Current Time

Age

The age fields allows for entry as an exact number of years, if known. If the exact
age of the individual is not known, the first box is the low end of the estimated age
range and the second box contains the high end of the estimated age range. If the
exact age of the individual is known, the second field is left blank.

ICIS Toolstation

The ICIS Toolstation allows quick access to all of the ICIS modules. The Toolstation is
displayed once the user has accessed any module within the ICIS system.

[ icts vaolstation ~Fasl

NFMO8CE

To access a specific module, point and click on the icon associated with the module,
Position the mouse pointer on an icon and the module name will be displayed in a ‘pop up’
text box. Use the mouse to single click on the desired icon to go to that module. A warning
message is displayed stating changes not saved, continue? Select no if you want to
save changes.

The Toolstation will not allow a user to go to modules to which they have not been granted
access. The Security module, discussed later during training, determines access.

The EXIT function button of the ICIS Toolstation will completely exit the system and close the
ICIS application. All unsaved data in the current module will be lost. To exit from ICIS,
use the EXIT function button.
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Entry Conventions

The TAB key will move the cursor from field to field in a forward fashion. This
forward TAB includes function buttons and short cuts.

A SHIFTITAB key sequence will move or 'back tab’ the cursor to the previous
field. This is helpful for correction during the data entry process.

The mouse can be used to position the cursor within a data field. Point and
click to the position within the field where the cursor is to be placed.

The mouse can also be used to move from tab to tab when adding or updating
a report. This provides easy access to data fields in all tabs and allows for
quick review before the report is added or updated.

HOME can be used to move the cursor to the beginning of the current field, or
in the case of the Narrative field, to the beginning of the current line.

END can be used to move the cursor to the end of the current line.
Using the SPACE BAR over existing text deletes the text.

Use Add (not Enter) when all the data has been keyed in. It is not necessary
to move the cursor to the end of a screen before using the Add. [t is not
necessary to use Add at the end of each tab.

Certain data fields are required and must be entered for the computer to
accept the report. It is useful to become familiar with them to improve speed
and efficiency.

The system will ‘beep’ to indicate either a warning to the user or readiness for
more data. For example, when a report is completed and Add is chosen, a
‘beep’ sounds if one or more field entries are incorrect or a required field is
blank.

Another indication of incorrectness is highlighting the field in error on the
screen. This is used for required data elements, which must be entered or
corrected before entry can progress further.

Double clicking or pressing F2 on a coded field will display the list of codes
available for that field. If the field is filled in, the description associated with
the current code will be displayed.

Pressing F3 after entering information in a Master Name block will perform a
Master Name search.
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Pressing F3 after entering information in a Master Vehicle block will perform a
Master Vehicle search.

Pressing F4 after entering the report number will perform a name search of all
names associated with the listed report number. This is beneficial in cases
where multiple reports are needed in different modules for the same
person(s).

Pressing F7 while in a narrative field will perform the spell check function.

To toggle the value of a check box, place the mouse on the control and click
the left mouse button. Once the control is highlighted, pressing the spacebar
will toggle the value.

Pressing Ctrl/Z is the same as “undo”.

12
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CALLS FOR SERVICE

The Calls for Service module is where the CAD data is deposited for use within the ICIS
Records System. From this module, the basic incident information is used and built-upon to
complete an incident report.

The Calls for Service module contains five sections: Main; Incident Times and Unit Histories,
POI, VOI and Narrative.

While the majority of this information is provided from the CAD system, some agencies
manually enter incidents into the ICIS system. Reasons could range from no CAD system
present, the CAD system was down or the incident was generated outside of the CAD
system.

Adding a Calls for Service Record

Upon accessing the Calls for Service module, the cursor is placed in the Incident#
field. This is where data entry begins. Notice that the screen has two parts: the top
contains the key fields regarding the incident's basic data; and below this are the
tabbed sections. The key fields remain constant within the display while the tabbed
sections change based on which section is being displayed.
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The Main tab contains data pertaining to the date and incident information relating to
the “whats” and “wheres” about the incident, as well as who phoned it in. The
Incident Times and Unit Histories tab contains the times associated with various
incident statuses as well as units assigned and their associated histories. By double-
clicking on a listed unit, that individuals unit's history, as associated with the incident,
is displayed.
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o PO! — Aliows for “Person of Interest” entry.
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Allows for “Vehicle of Interest” entry.

The Narrative tab contains any existing CAD narrative as well as offering the ability to
add additional narrative as part of the incident report. The Narrative tab also offers

O spell-checking features.
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Redquired Fields

The Calls for Service module has required fields that must be completed before the
Add process can be finalized. Adding Calls for Service records will only be done by
those agencies not utilizing CAD data. These include:

AGENCY (Alphanumeric, System-supplied)
INCIDENT# (Alphanumeric)

DATE REPORTED (MMDDYYYY)

CALL TYPE (Coded)

RD (Coded)

RECEIVED TIME (HHMMSS)

Don't worry if a required field is forgotten. The system will display a message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the field needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.

During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fields (the ones
that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-clicking
with the mouse. Refer back to Special Data Fields for more information.

When all the data has been entered into each respective tab, use the Add function
button to add the report to the database. lt is not necessary to use the Add function
button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. In addition,
each user can have their security set-up to include the clearing of the screen upon
adding and/or updating reports. By selecting the ALWAYS CLEAR feature, the
screen is always clear for new entry after each add/update, thus eliminating the need
to manually clear the screen. A benefit for not selecting the ALWAYS CLEAR
function is during frequent adds/updates, the user is not required to re-enter the
report number for retrieval. The information is left on the screen for further action,
Then itis up to the user to clear the screen manually once they have finished with the
one report. Each user should try both methods to determine which offers them the
most benefits.

Master Location
All location information is stored in the Master Location table, regardless of the
module it was entered in. When location information is entered, it can be
checked against existing records to eliminate duplicate files, populate fields
with existing data to reduce keystrokes and check for warnings. To access
Master Location information, enter a location then press the Master Location
Search icon.

PSSI

17



ICIS Re ords Management System

Agoncy mcidont ¥ Dste Call Typo Clﬂ‘l'ypeﬂaurlpt_:i.ﬂ_
A T ] AT A |
1.Main l} 2Ancidert Times snd Unit Histories | 1. Harrative

Bidg  Apt# Strte ' Coty - 'Zip I tew Addrr

e ]_;j = -lc:F—_.—l_-‘{_' e, AT l‘ |

r r _F_M‘.
MASTER L T Nepstchor 10 NEpstcher Harme b KL%
LOCATION B H | el
SEARCH Sispos o e e e e g P R 1, S e )
e . E |
2 AT | Admess Gl Mose |
E— : — E—
Rotated incidents:
Potce St E R AT E s SO e
| L ' B | _—I | o ]
Brouious] Search I Hewi E Add ] Updste ] Detotn I Cloar _] it r

During the search process, an address validation is performed. If errors are found,
alternatives are displayed, if any, and the user can make selections from a pick list. If
the entered criteria matches one or more entries in the Master Location table, a list of
matching record(s) will be displayed. The user can view details from the list and then
make a selection to have location data be transferred back to their original entry form.
Refer to the Master Location Module for further details.

Retrieving a Calls for Service Record
The ICIS system offers three methods for retrieving records. One is to enter data into
one or more fields on a blank Calls for Service screen and then use the Search
function button.

The second is to use the Range Search menu option. This displays the Range
Search screen where criteria can be entered. When done, use the Search function
button. If you accessed this screen by mistake, use the Cancel button to return to
the Calls for Service screen. The Clear function button clears the fields for a new

search.
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ienrr.hJ Closr J Cancel _1

The third is to use both the fields from the Calls for Service screen and the Range
Search screen. Remember, in either case, the more information entered, the more
restrictive the search will be. If the search results in the retrieval of more than one
record, the List of Candidates’ screen is displayed.
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if the number of records selected exceeds the minimum threshold, a message is
displayed. Pressing the Yes function button will bring up the list of candidates.
Pressing the No function button will allow for entry of additional search criteria that
may be used to reduce the number of records selected.

489 records found, Continue?

Should the selected records exceed the maximum thresholds, a message at the top
of the screen highlighted in red will be displayed indicating the search criteria must be
modified. Enter additional criteria and perform the search again. Your System
Administrator determines thresholds.
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The List of Candidates display offers the capability of sorting by simply clicking on the
respective column header. The selected column wil then sort the entries.
Additionally, the List of Candidates can also be temporarily rearranged by dragging a
column header. Simply point and hold the left mouse button while you drag the
column to the desired order within the screen.

To access a record within the List of Candidates, highlight the desired incident and
either double-click with the mouse or use the Select function button. The screen is
then filled with the data of the selected record. Notice that the selected record will
display within the title bar its location with the List of Candidates (Record # 21 of 248).
This allows the user to use the Previous and Next function keys to scroll forward or
back through the List of Candidates without having to redisplay the list itself.
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The List of Candidates can be redisplayed by selecting List from the menu bar and
access a different record as before. Should you want to perform a new search, ciear
the List of Candidates display by selecting ClearList from the menu bar. While
clearing the screen is recommended, it is not required.

In addition to standard searches, the Calls for Service module offers three other
searches. The first, Unit # Search allows users to search for incidents that contain
certain Unit #s. This is helpful when you may not know any incident information, but
you know it involved 1A12. The List of Candidates would display all calls 1A12 has
been assigned to. The second is the DR # Search which allows users to search for
certain DR numbers. DR numbers are used by agencies that want separate,
sequential report numbers, The third is the CAD Narrative Search, which allows
users to search for incidents that contain certain words or phrases. Again, helpful
when you may not know any incident information, but you know it involved a red
corvette. The List of Candidates would display all calls that contain “red corvette”
text.
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Options Menu

Once a record is retrieved, there are times you may want to view data associated with
the record. Such data could be within the record history itself or through attached
modules. These features are found in the Options menu.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological list of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Offense
The View Offense option permits the operator to view the related Offense
information of the displayed calls for service record.

Updating a Calls for Service Record

Updating records requires special security clearance. Security will be discussed in a
later section. If clearance has been granted, use the methods discussed previously
to retrieve the record needing to be updated. A record cannot be updated until it is
retrieved. Perform the necessary changes, additions, or removal of data within the
report. Once complete, use the Update function button. The system will display a
message stating the record has been updated.

Printing a Calls for Service Record

The Calls for Service module allows the user to print the displayed screen or the
entire report. These features, shown below, are accessed from the Eile option of the
menu bar.

Print Screen
The Print Screen option permits the operator to print the currently displayed
screen,

Print Current Record
The Print Current Record option permits the operator to print the current
record and not just the currently displayed screen.

Additionally, the List of Candidates from a search can be printed into a hard-copy list.
From the List of Candidates display, select the File option from the menu bar and
then select the desired print option.

Print Screen
The Print Screen option permits the operator to print the currently displayed
list of candidates screen.

Print List
The Print List option permits the operator to print the entire list of candidates.

PSSi
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ENTRY OF AN OFFENSE REPORT

OFFENSE

The Offense module is the starting point of the records system. The Offense module gives
an overview of the entire incident from CAD creation to Case Management. From this
module, the offense information and the linked modules are used to create a complete

report.
Adding an Offense Report
Upon accessing the Offense module, the cursor is placed in the Report Number field.
This is where data entry begins. Notice that the screen has two parts: the top
contains the key fields regarding the offense's basic data; and below this are the
tabbed sections. The key fields remain constant within the display while the tabbed
sections change based on which section is being displayed.
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Before we begin data entry, let's familiarize ourselves with the Offense module. The
Offense module contains six sections: Main; Offenses; Prop/Veh/Invest; Narrative;
incident Summary; and 77. These provide the basic details about the offense in a
condensed form for easy viewing. The Main tab contains data pertaining to the
offense location, incident information, as well as disposition.

22

PSSI



ICIS Records Management System

The Offenses tab contains an offense grid, which allows the user to enter one or

) multiple offenses. Also, when a value is entered into the OFFENSE field, the
corresponding entries from the UCR cross-reference and the IBR cross-reference
tables will be placed into the appropriate UCR CODE and IBR CODE fields just
below. Provided there is a match found on the offense code entered. Once an
offense code is entered into the grid, the main offense will automatically appear on
the Main tab.
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The Prop/Veh/Invest tab contains data pertaining to any property/vehicles involved in
the offense, the investigative officer(s) assigned, as well as any supplemental
namratives and drug information. The property/vehicle fields are related to other
modules for UCR reporting and work in conjunction with the incident Summary tabs
when performing validations. As data is entered, it is matched up to data entered in
the Property and/or Vehicle module(s).

Also, when dealing with UCR reporting, certain guidelines apply. In most cases,
vehicles are not considered property. The exception to this is carjacking. As
carjacking is considered a higher offense than a stolen vehicle, the vehicle now
becomes property to eliminate any conflicts during the UCR reporting.

Now that you have seen how vehicles can become property, let's talk about how
property can become vehicle-related. When reporting any property from a stolen
vehicle, the user needs to determine if the property is vehicle-related or not. Some
vehicie-related items include stereo components, while non-vehicle-related items
include clothing, tools, etc. Once determined, the property is included in the
appropriate fields, whether it be property or vehicle information fields.
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The Narrative tab allows for narrative to be entered as part of the offense report. The
Narrative tab also offers spell-checking and large font features.
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The Incident Summary tab dispilays associated information gathered from the linked
modules. The incident Summary tab also performs discrepancy checks to validate
entries within a linked module are properly noted in the Offense module as well.
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IC|S provides the ability to utilize a report approval system. This Workflow process is
a flag setting that turns on the Workflow tab for the necessary modules (i.e. Offense,
Arrest, Invoived Parties, Property, Accident, Suspect, Citations, Vehicles, etc.) The
Workflow process allows the reporting officer to submit reports to be electronically
Signed.
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The Offense module offers links to Victim, Suspect, Involved Parties, Arrest, Property,
Vehicle, Citation, and Case Management. These links, shown along the right-hand
side of the window, allow the user to jump to associate modules for data entry without
having to exit the Offense report, as well as using existing data to populate fields.

The agency, offense number and suffix must be entered prior to accessing the other
modules. These fields will be passed to the chosen module, and if a record for that
module exists, it will be displayed. If multiple records exist, a list of candidates will be
displayed. This feature can be used during data entry to speed up the entry of
related information or during retrieval and updating to view related information without
having to leave the Offense screen.

Retrieve CFS

At the beginning of data entry, it is best to see if existing CAD data is
available. By using CAD data, data entry can be reduced. Type in the report
number (also known as the incident number) and access the Retrieve CFS
option from the File menu. [f data is available, it will be transferred to the
appropriate fields within the Offense screen. If the report number is unknown,
use the Range Search menu option.
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When all desired search criteria has been entered, press the Search function
button to initiate the search. The radio buttons at the bottom of the screen
allow the user to limit the search to find Calls for Service records for which no
Offense exists, which is a useful function to determine if any incident reports
are missing. The date and time reported and all location information are
transferred from the Calls for Service record to the corresponding fields in the
Offense report.

Required Fields
The Offense module has required fields that must be completed before the Add

process can be finalized. These include:

AGENCY (Alphanumeric, System-supplied)
REPORT NUMBER (Alphanumaeric)
SUFFIX (Numeric)

REPORT DATE (MMDDYYYY)

TIME (HHMMSS)

SHIFT (Coded)

RD (Coded)

OFFENSE (Coded)

UCR CODE (Coded)

OCCUR/EARLIEST DATE (MMDDYYYY)
OCCUR TIME (HHMMSS)

Don't worry if a required field is forgotten. The system will display a message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the field needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.
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Additionally, the LOCKED? field in the upper right corner allows the user to limit
access to the report. If checked, only users authorized to view locked records will be
able to view and/or access the report. This is primarily used when the offense being
reported is of a sensitive nature or involves agency personnel.

During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fields (the ones
that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-clicking
with the mouse. Refer back to Special Data Fields for more information.

When all the data has been entered into each respective tab, use the Add function
button to add the report to the database. It is not necessary to use the Add function
button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. In addition,
each user can have their security set-up to include the clearing of the screen upon
adding andfor updating reports. By selecting the ALWAYS CLEAR feature, the
screen is always clear for new entry after each add/update, thus eliminating the need
to manually clear the screen. A benefit for not selecting the ALWAYS CLEAR
function is during frequent adds/updates, the user is not required to re-enter the
report number for retrieval. The information is left on the screen for further action.
Then it is up to the user to clear the screen manually once they have finished with the
one report. Each user should try both methods to determine which offers them the
most benefits.

If this Offense report contains data related to any linked modules, you can either add
now and then process the linked modules, or simply continue the entry process and
add at the end. - As a safeguard, it is always best to frequently use the ADD function
to save entered data. For this example, our Offense report is going to contain data
within all the linked modules. We will be following the order of the linked modules,
starting with Victim.

In addition to adding records, the system offers other actions such as refrieving,
updating and deleting records.

Retrieving Records

The ICIS system offers three methods for retrieving records. One is to enter data into
one or more fields on a blank screen of the Offense module and then use the Search
function button.

The second is to use the Range Search menu option. This displays the Range
Search screen where criteria can be entered. When done, use the Search function
button. If you accessed this screen by mistake, use the Cancel button to return to
the module screen. The Clear function button clears the fields for a new search.

28

PSSi



ICIS Records Management System

B
Fila  Help
Record Selection Criteria
Agency  Froen Offense num Stx To Offense num Sfx
aaml mm) L1
Raport From Date To Date Report From Time  To Tume
Do— | - | B | [== |
Seerch I Clesr I Cencel J

The third is to use both the fields from the Offense screen and the Range Search
screen. Remember, in either case, the more information enterad, the more restrictive
the search will be. If the search results in the retrieval of more than one record, the

List of Candidates’ screen is

displayed.

discussed in detail within the Calls for Service section.

Options Menu

The List of Candidates features are

Once a record is retrieved, there are times you may want to view data associated with
the record. Such data could be within the record history itself or through attached

modules. These features are found in the Options menu.

View Workflow Notes
Any notes attached to a Workfiow process are viewable from this selection.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological list of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Record Information

The View Record Information option permits the operator to view the original
incident record entry. This differs from the View Audit Trail option in that any
records that have not be updated are not available in the Audit Trail. Thus to
view these unabridged incidents, the View Record Information is provided.

View Calls for Service

The View Calls for Service option permits the operator to view the Calls for
Service record associated with the Offense record. This provides the operator
with a glance of the incident the officers responded to as well as any radio text
entered during the incident.

PSS
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View Attachments

This option allows you to save documents to the Offense Report. These
documents can be any file type, such as Word, PowerPoint, Excel documents,
or photo images, such as jpg and bmp. This allows the user to scan in
documents, such as witness written statements, signed Miranda forms, etc.
To add an attachments to the Offense Module, select the View Attachments
functions from the Options menu on the toolbar. This will present the end user
with the following screen.
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Selecting the Add button will take you to the Browse for file screen. Find file
to be attached and click open. This will add the attachment.

To view an attachment, simply double click the file name, or single click to
highlight file and select View.

The Copy to function allows you to copy a document to another location. To
do this, highlight the file you wish to copy, select the Copy to button and
select the desired location.

The Remove button allows you to remove a document by highlighting the
document and selecting the remove bution.

Set Default Values

The Set Default Values option toggles whether the values associated with the
City, State, and/or Zip Code that were entered into the Admin Table for the
Agency's personal information are entered as defaults. This eliminates having
to enter these values for addresses that fall within the same geographical area
as the agency's address.

Updating Records

Updating records requires special security clearance. If clearance has been granted,
use the methods discussed previously to retrieve the record needing to be updated.
A record cannot be updated until it is retrieved. Perform the necessary changes,
additions, or removal of data within the record. Once complete, use the Update
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function button. The system will display a message stating the record has been
updated.

Deleting Records

Deleting records requires special security clearance. If clearance has been granted,
use the methods discussed previously to retrieve the record needing to be deleted. A
record cannot be deleted until it is refrieved. Use the Delete function button and a
confirmation message will be displayed to verify the deletion process. Selecting YES
will delete the record; selecting NO will abort the deletion process.

Printing Records

The Offense module allows the user various print options. These features, shown
below, are accessed from the File option of the menu bar.

Print Screen
The Print Screen option permits the operator to print the currently displayed
screen.

Print Incident Report - Current

The Print Incident Report - Current menu option permits the operator to print
the entire incident report of the current displayed record or to select specific
modules to be printed. A checkmark next to the module indicates that
information will be included with the report.
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After selecting the desired modules, pressing OK will generate the Print
Preview feature allowing the user to view how the printed report will look like
before actually beginning the print process.
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In addition, options within the Appearance menu allow the user to change
how the report looks. Colors of headers, sub-headers, field headers, and field
detail are all user-selectable. These settings can also be set to be the default
values for future prints.

Also, a Whiteout Character feature has been added to allow the user to select
sensitive information and have this data electronically “whited-out” prior to
being printed. This provides a quick and easy method for printing reports
while at the same time removing any sensitive data not allowed to all
personnel or public. Also, a checkbox in the lower left corner allows for
indicating “black and white” prints only and field for entering the number of
copies fo be printed.

Once the output of the report is acceptable, the Print button executes the
printing process. Should the report not be what the user was looking for, the
Exit button returns the user to the Offense module. If this report needs to be
saved, the File menu offers the ability to save the record, allowing the user to
select the name and file location of the record.

Print Incident Report - List
The Print Incident Report - List menu option permits the operator to print the
entire incident report for each of the records returned in the current search list.

Custom Reports

Should the Offense report be complete, reports can be created from the available data. In
addition to canned reports located in the Reports module, customers can purchase custom
reports created by PSSI. These reports are located in the Offense module accessed from

the File menu.
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The Custom Reports menu option permits the operator to print custom reports using the
current record's basic data. By clicking on Custom Reports, a list of available reports is
displayed. Once the desired Custom Report is selected, an interactive form is displayed
where the user can point-and-click on fields within the report display to input data.
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A window, confirming the field selected, is displayed, requesting the user to “enter the new
value”. Once entered, press the OK button and the entered data is now displayed within the
form. if this field was displayed by mistake, press the CANCEL button to return to the report
display without updating.

Are you taking medication? {

Enter New Value 0K I

The ICIS Custom Report form offers various features, which can be accessed from either the
drop-down menus or from the displayed icons. These features include zooming the screen,
show/hide field boundaries, refresh data, and print. Other features include changing font
size, including text fields, and erase.
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INVOLVED PARTIES

This module captures and displays data about all people involved with an incident. Involved
parties include victims, complainant, missing person, witnesses, passengers, etc.

Adding an Involved Parties Report

Upon accessing the Involved Parties module, the cursor is placed in the
Report/Contact # field. This is where entry begins. Notice that the screen has two
parts: the top contains the key fields regarding the involved party; and below this are
the tabbed sections. The key fields remain constant within the display while the
tabbed sections change based on which section is being displayed.
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The Involved Parties module contains seven sections: Main; Personal; Appearance:;
AKA/ Offense; History/Narr; Acc/Supp; and Workflow. The Main tab, as shown
above, contains the Master Name information for the person, as well as data
pertaining to the date, time and circumstances of the involvement.

PSSI



ICIS Records Management System

The Personal tab allows for the entry of data related to the address, employment and
| vehicle of the involved party.
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The Appearance tab contains information concerning the distinctive markings,
O physical characteristics and clothing of the involved party, as well as any associated
images.
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The AKA/Offense tab contains information on the aliases and gang references
associated with the involved party. In the Offense Related Information section, the
IBR CODES contain up to 10 offenses the individual was a victim to. By pressing the
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F4 function key while in any of the IBR CODES fields, all the IBR codes entered in
the associated Offense report are pulled into these fields. And in the Victim/Cffender
Relationship section, pressing the F4 function key while in the Offender # field will pull

a list of entered suspects to be inserted into the grid.
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The History/Narr tab displays the contact history of the involved party as well as
narrative associated with the Involved Party report. The narrative portion also offers a
spell-checking feature.,
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The Acc/Supp tab contains accident information as well as supplemental military
information. Just like in the Offense module, complete the necessary fields to add a

report.
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The Workfiow tab offers the ability for the responsible parties to sign off on the report.
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Master Name

All name information is stored in the Master Name table, regardless of the
module it was entered in. When name information is entered, it can be
checked against existing records to eliminate duplicate files, populate fields
with existing data to reduce keystrokes and check for warnings. To access
Master Name information, enter one or more fields that deal solely with an
individual (name, DOB, height, etc.) then press the Master Name Search icon.
If the entered criteria matches one or more entries in the Master Name table,
a list of matching record(s) will be displayed. Search criteria include
soundexing and range settings.
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A soundex search is one where a code is produced from the individual's name
(first, middle, and/or last names) and the system searches for any similar
sounding names. The soundex mechanism utilizes a special coding scheme
developed by the New York Identification and Intelligence System (NYSIS).
This coding scheme, in addition to handling the normal phonetic variations,
effectively incorporates orthographic errors, which occur in the recording of
Spanish and other Southern European names. In any case, a list of similar
sounding names is presented for possibie selection.

In addition to searching by names, physical characteristics can be included as
search criteria. As physical characteristics offer many variables, ranges
above and/or below the requested criteria can be set to provide thresholds
when performing searches. The System Administrator sets these range
parameters in the Admin Tables of the ICIS system. Please refer to the
Master Name Range table for further information.

To view a record, double-click on the row or tab to the list then use the arrows
to highlight the row and press the Enter key. Upon selection, an individual
detail screen is displayed. If the information matches the current individual,
use the Select button. This action will return all Master Name data from the
selected record to be inpuited into the record currently being processed. The
New Name? box will be unchecked, as the individual already exists. Should
the individual not exist, the New Name? box should be checked to create a
new Master Name record.

If the selected record does not match, simply return to the list by accessing
the 2. Results tab to view another record. If none of the names match, use
the xReturn button to return to the data entry screen where the Master Name
search was performed.
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Warnings

Once an individuail's name has been entered, if any existing data is found we
have seen how it can populate fields to reduce keystrokes. In addition, should
hazardous information be associated with the individual, the user is presented
with this information as a warning. The Warnings button will flash as well as a
yellow message banner at the top of the screen will be presented to the user
to bring to their attention of hazardous information. This is helpful when just
doing searches for officers in the field who need to be notified of potential
dangerous situations. To add a Warnings alert, click on the Warnings button
which displays an entry window. Type in the necessary fields and use the
Insert Into Grid button and then the Save and Exit button.
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Master Vehicle

All vehicle information is stored in the Master Vehicle table, regardless of the
module it was entered in. When vehicle information is entered, it can be
checked against existing records to eliminate duplicate files, populate fields
with existing data to reduce keystrokes and check for warnings. To access
Master Vehicle information, enter one or more fields that deal solely with a
vehicle {make, color, license plate, etc.) then press the Master Vehicle Search
icon. If the entered criteria match one or more entries in the Master Vehicle
table, a list of matching record(s) will be displayed.
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To view a record, double-click on the row or tab to the list then use the arrows
to highlight the row and press the Enter key. Upon selection, an individual
detail screen is displayed. If the information matches the current vehicle, use
the Select button. This action will return all Master Vehicle data from the
selected record to be inputted into the record currently being processed. The
New Vehicle? box will be unchecked, as the vehicle already exists. Should
the vehicle not exist, the New Vehicle? box should be checked to create a
new Master Vehicle record.

If the selected record does not match, simply return to the list by accessing
the 2. Results tab to view another record. If none of the names match, use
the xReturn button to return to the data entry screen where the Master
Vehicle search was performed.

Master Location

As discussed in Calls For Service, all location information is stored in the
Master Location table, regardiess of the module it was entered in. This
provides a quick method for checking against existing records to efiminate
duplicate files, populate fields with existing data to reduce keystrokes and
check for warnings. Refer to Calls For Service or the Master Location Module
for more information.

Images and Mugshots
Various images can be stored within most modules. Mugshots can be
associated to individuals, as well as any photos of unique physical
characteristics. Function buttons allow the user to maintain such types of
information.
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FUNCTION
BUTTONS
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Get Image. This function is used to select an image or mugshot from a
directory tree. By using the Get Image button, a directory tree is displayed to
access the necessary files. When the appropriate image file is located, click
on the filename to temporarily place it in the picture box for viewing. After
getting the image, the buttons will be re-titled to reflect the next process.

Add Image. When the Get Image button is accessed, it changes to Add
Image. This function is used to add the displayed image to the existing
record. The user must use the Add Image button to add the image to the
record. When the image is added, the # image textbox value is increased by
one.

Del Image. This function is used to delete the displayed image from the
existing record. The user must use the Del image button to delete the image
from the record. When the image is deleted, the # image textbox value is
decreased by 1. This button will not display during the add process. By using
the Done button, the Del Image button will be redisplayed.

Done. This function is used to clear the directory tree from the screen. The
user must use the Done button to remove the directory tree.

Image Type. This field describes the type of image being displayed. Options
can include front, profile, etc.

Image Size. The size of the image of the subject. Options include Scanner,
Landscape, and Portrait. In addition, the image box automatically adjusts
according to the size of the image selected.

# Images. This field displays the number of images associated to the existing
record. This field will increase and decrease as the operator adds or deletes
image records.
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Grids

Throughout the Involved Parties module, various grids are utilized to capture
data. The grids within Involved Parties are the Scars/Marks/T attoos/Clothing,
Aliases, and Victim/Offender Relationship sections. The input of data within a
grid is accomplished by typing the data into the fieids at the bottom of the grid
area. After entry, press the INSERT button to have the data inserted into the
grid. Should grid data need to be removed, first access the entered data by
double-clicking on the line item within the grid display. Once accessed, the
entry fields are filled in with the associated data. Now you can press the
REMOVE button to remove the entry from the grid. The CANCEL button
offers the capability of clearing any previously entered grid fieids to begin a
new entry.

Required Fields
The Involved Parties module has required fields that must be completed before the
Add process can be finalized. These include:

AGENCY (Alphanumeric, System-supplied)
REPORT/CONTACT # (Alphanumeric)
SUFFIX (Alphanumeric)

REC # (Numeric)

REC TYPE (Coded)

LAST NAME (Alphanumeric)

Don't worry if a required field is forgotten. The system will display a message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the field needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.

Additionally, the LOCKED? and JUVENILE? fields in the upper right corner allow the
user to limit access to the report. If checked, only users authorized to view locked
and/or juvenile records will be able to view and/or access the report. The locked
feature is primarily used when the offense being reported is of a sensitive nature or
involves agency personnel. The juvenile feature keeps juvenile records private per
federal mandates.

During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fields (the ones
that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-clicking
with the mouse. Refer back to Special Data Fields for more information.

When all the data has been entered into each respective tab, use the Add function
button to add the report to the database. It is not necessary to use the Add function
button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. Once
complete, use the xReturn function button to return to the original Offense report. A
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summary of the victim and/or other involved party information should now be
displayed under tab #7. Victim/Involved Parties. Now we can move onto the next
linked module, Arrest.

Options Menu

The Involved Parties module offers various options for interacting with data. Such
options include viewing associated data or clearing certain fields to facilitate entry of
cloned records. These features are found in the Options menu.

View Workflow Notes
Any notes attached to the Workflow process are viewable from this selection.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological list of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Offense
The View Offense option permits the operator to view the related Offense
information of the displayed record.

View Record Information

The View Record Information option permits the operator to view the original
incident record entry. This differs from the View Audit Trail option in that any
records that have not be updated are not available in the Audit Trail. Thus to
view these unabridged incidents, the View Record Information is provided.

Clear Name Info

The Clear Name Info option clears all Master Name information from the
current record, including address, military and employment information as well
as any associated aliases or scars, marks or tattoos.

Clear Veh Info
This Clear Veh Info option clears all Master Vehicle information from the
current record.

Set Default Values

The Set Default Values option toggles whether the values associated with the
City, State, and/or Zip Code that were entered into the Admin Table for the
Agency's personal information are entered as defaults. This eliminates having
to enter these values for addresses that fall within the same geographical area
as the agency's address.

Printing Records

The Involved Parties module allows the user to print the displayed screen or the
entire report. These features, shown below, are accessed from the File option of the

menu bar.
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Print Screen
The Print Screen option permits the operator to print the currently displayed

screen.

Print Involved Party Report
The Print Involved Party Report menu option permits the operator to print the
entire involved party report of the currently displayed record.

Print List of Candidates

The List of Candidates from a search can be printed into a hard-copy list.
From the List of Candidates display, select the File option from the menu bar
and then select the desired print option.
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ARREST

The Arrest module captures and displays data about all people entered into the system who
have been arrested.

Adding an Arrest Report

Upon accessing the Arrest module, the cursor is placed in the Report # field. This is
where entry begins. Notice that the screen has two parts: the top contains the key
fields regarding the arrest's basic data; and below this are the tabbed sections. The
key fields remain constant within the display while the tabbed sections change based
on which section is being displayed.
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The Arrest module contains eight sections: Main; Personal; Charge/IBR; Appearance;
AKA/ Narr; Supp; DUI; and Workflow. The Main tab, as shown above, contains the
Master Name information for the person, as well as data pertaining to the date, time
and circumstances of the arrest.
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The Personal tab allows for the entry of data related to the address, employment and
vehicle of the arrestee.

R

Fin . Lt Deorlist | Blangs Seach - “Optiorm - Hel

Agoncy | Report SuMe  Rocd  Bookingd Purge 3
fr L JeL_ i TE - ke T S e |
Wan ] gresomt | AChargeltR | $Apoweamnce | fARARST I #Ser | 108 ] porkiow
Address:
Locstion Bidg Aty Cuy Heta B Cry Rt 2l e ] |
Phons RD of Ras mqal':—'—ILm_uuT uor—_ Tm%’rmm#
O N | ) I~ us Citizent |
Emplayment; 1
Employer Occupation Phone &t Q
Location Bldg  Apls  Cay Site Coty  Zp §
. i ey
Vebicie:
i Make Moded Styte Yousr Veh Type
| — T | a I & |
Color 1 Color 2 Licanaa # Stata Top Expr Tag Typa
i S [ ] i l=— }i I Mew Vaticia T
Prewous I Soarch | Hext I Add ' Updats l Delste i Choar ' Egt I

The Charge/IBR tab allows for the entry of incident-based reporting data. The charge
number, offense number and suffix, charge type, section/charge, number of counts
and IBR code are required for a charge to be inserted into the grid. Charge records

O with the same section/charge are not allowed. By pressing the F4 function key while
in Section/Charge field, all the offense codes entered in the associated Offense report
are pulled into the appropriate fields.
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The Appearance tab contains information concerning the distinctive markings,
physical characteristics and clothing of the arrestee, as well as any associated
images.
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The AKA/Narr tab contains information on the aliases and gang references
associated with the arrestee, as well as narrative associated with the Arrest report.
The narrative portion also offers spell-checking and large font features,
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The Supp tab contains information including the circumstances surrounding the
reading of rights, telephone calls and questions associated with the arrest, as weil as
military information associated with the Master Name tables.
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The DU! tab contains information on
the individual during the DU! testing process.
complete the necessary fields to add a report.
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the specifics of the location and appearance of
Just like in the Offense module,
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The Workflow tab offers the ability for the responsible parties to sign off on the report.
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Retrieve Booking

With the use of the Retrieve Booking option from the File menu, utilizing
information from the existing Booking report to begin the Arrest report can
reduce data entry. To use the Retrieve Booking function, at least one of the
following fields must be filled in: Booking Number, Name, Race, Sex and/or
DOB. Wildcards may be used in the Arrest Number field, as well as in all
Name fields. In addition, a soundex option is available for searches involving
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a Last Name. Once all of the search information has been entered, select the
Retrieve Booking option from the File menu. If a matching Booking report is
found, the Master Name, Master Vehicle, Body Marking, Alias and Booking
information from the Booking report will be brought into the Arrest report. |f
more than one matching Booking report is found, a list of candidates will be
displayed from which the operator may select the exact record to use for
bringing the Booking data forward.

Retrieve Suspect

With the use of the Retrieve Suspect option from the File menu, utilizing
information from the existing Suspect record to begin the Arrest record can
reduce data entry. To use the Retrieve Suspect function, at least one of the
following fields must be filled in: Incident Number, Name, Race, Sex and/or
DOB. Wildcards may be used in the Arrest Number field, as well as in all
Name fields. In addition, a soundex option is available for searches involving
a Last Name. Once all of the search information has been entered, select the
Retrieve Suspect option from the File menu. If a matching Suspect record is
found, the Master Name, Master Vehicle, Body Marking, Alias and Suspect
information from the Suspect record will be brought into the Arrest record. If
more than one matching Suspect record is found, a list of candidates will be
displayed from which the operator may select the exact record to use for
bringing the Suspect data forward.

Retrieve Warrant

With the use of the Retrieve Warrant option from the File menu, data entry
can be reduced by utilizing information from the existing Warrant record to
begin the Arrest record. To use the Retrieve Warrant function, at least one of
the following fields must be filled in: Warrant Number, Name, Race, Sex
and/or DOB. Wildcards may be used in the Arrest Number field, as well as in
all Name fields. In addition, a soundex option is available for searches
involving a Last Name. Once all of the search information has been entered,
select the Retrieve Warrant option from the File menu. If a matching Warrant
record is found, the Master Name, Master Vehicle, Body Marking, Alias and
Warrant information from the Warrant record will be brought into the Arrest
record. If more than one matching Warrant record is found, a list of
candidates will be displayed from which the operator may select the exact
record to use for bringing the Warrant data forward.

Master Name
As discussed in Involved Parties, all name information is stored in the Master
Name tabie, regardless of the module it was entered in. This provides a quick
method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Warnings
As discussed in Involved Parties, should hazardous information be associated
with the individual, the user is presented with this information as a warning.
Refer to involved Parties for more information.
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Master Vehicle

As discussed in Involved Parties, all vehicle information is stored in the Master
Vehicle table, regardless of the module it was entered in. This provides a
quick method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Master Location
As discussed in Calls For Service, all location information is stored in the
Master Location table, regardless of the module it was entered in. This
provides a quick method for checking against existing records to eliminate
duplicate files, populate fields with existing data to reduce keystrokes and
check for warnings. Refer to Calls For Service or the Master Location Module
for more information.,

Images and Mugshots

As discussed in Involved Parties, various images can be stored within the
Arrest module. Refer to Involved Parties for more information.

Grids
Throughout the Arrest module, various grids are utilized to capture data. The
grids within Arrest are the Charges, Scars/Marks/Tattoos/Clothing, and
Aliases sections. Refer to Involved Parties for more information on entry and
removal.

Required Fields
The Arrest module has required fields that must be completed before the Add

process can be finalized. These include:

AGENCY (Alphanumeric, System-supplied)
REPORT # (Alphanumeric)

SUFFIX (Alphanumeric)

RECORD # (Nurneric)

LAST NAME (Alphanumeric)

ARREST DATE (MMDDYYYY)

ARREST TIME {Numeric)

Don't worry if a required field is forgotten. The system will display a message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the fieid needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.

Additionally, the LOCKED? and JUVENILE? fields in the upper right corner allow the
user to limit access to the report. If checked, only users authorized to view locked
and/or juvenile records will be able to view and/or access the report. The locked
feature is primarily used when the offense being reported is of a sensitive nature or
involves agency personnel. The juvenile feature keeps juvenile records private per
federal mandates.
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During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fields (the ones
that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-clicking
with the mouse. Refer back to Special Data Fields for more information.

The Arrest module offers some shortcuts. On the Main tab, the person's age will be
calculated automatically if a valid birth date is entered. On the Charge/IBR tab, the
charge number, offense number / suffix, charge type, section / charge, number of
counts and IBR code are required for a charge to be inserted into the grid. Charge
records with the same section / charge are not allowed. Also, pressing F4 while in
the Section/Charge field will display a list of all offense codes entered in the Offense
Module. When a value is entered in the Section/Charge field, the corresponding
entries from the UCR cross-reference and the IBR cross-reference tables will be
placed in the UCR and IBR fields, provided a match on the Section/Charge is found in
the tables. In addition, pressing F4 while in the Drug Type field will fill in the drug
number entered from the original Property report.

When all the data has been entered into each respective tab, use the Add function
button to add the record to the database. It is not necessary to use the Add function
button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. Once
complete, use the xReturn function button to return to the original Offense report. A
summary of the arrest information should now be displayed under tab #8.
Suspect/Arrest. Now we can move onto the next linked module, Suspect.

Options Menu

The Arrest module offers various options for interacting with data. Such options
include viewing associated data or clearing certain fields to facilitate entry of cloned
records. These features are found in the Options menu.

View Reject Notes
Any notes attached to a rejection from the Workflow process are viewable
from this selection.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological list of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Offense
The View Offense option permits the operator to view the related Offense
information of the displayed record.

View Record Information
The View Record Information option permits the operator to view the original
incident record entry. This differs from the View Audit Trail option in that any
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records that have not be updated are not available in the Audit Trail. Thus to
view these unabridged incidents, the View Record Information is provided.

Clear Name Info

The Clear Name Info option clears all Master Name information from the
' current record, including address, military and employment information as well

as any associated aliases or scars, marks or tattoos.

Clear Veh Info
This Clear Veh Info option clears all Master Vehicle information from the
current record.

Set Default Values

The Set Default Values option toggles whether the values associated with the
City, State, and/or Zip Code that were entered into the Admin Table for the
Agency's personal information are entered as defaults. This eliminates having
to enter these values for addresses that fall within the same geographical area
as the agency's address.

Printing Records
The Arrest module allows the user to print the displayed screen or the entire report.
These features, shown below, are accessed from the File option of the menu bar.

Print Screen
The Print Screen option permits the operator to print the currently displayed
screen.

Print Arrest Report
The Print Arrest Report menu option permits the operator to print the entire
arrest report of the currently displayed record.

Print List of Candidates

The List of Candidates from a search can be printed into a hard-copy list.
From the List of Candidates display, select the File option from the menu bar
and then select the desired print option.
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SUSPECT

The Suspect module captures and displays data about suspects entered into the system.

Adding a Suspect Report

Upon accessing the Suspect module, the cursor is placed in the Report Number field.
This is where entry begins. Notice that the screen has two parts: the top contains the
key fields regarding the suspect; and below this are the tabbed sections. The key
fields remain constant within the display while the tabbed sections change based on
which section is being displayed.
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The Suspect module contains seven sections: Main, Personal; AKA/ Narr;
Appearance, Offense/MO; Registrant; and Workflow. The Main tab, as shown above,
contains the Master Name information for the suspect, as well as vehicle information.
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— The Personal tab allows for the entry of data related to the address, employment and
' military status of the suspect.
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The AKA/Narr tab contains information on the zliases and gang references
associated with the suspect as well as narrative associated with the Suspect record.
O The narrative portion also offers a spell-checking feature.
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The Appearance tab contains information concerning the distinctive markings,
physical characteristics and clothing of the suspect, as well as any associated
images.
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The Registrant tab contains information on the individual required to register with
local agencies. Just like in the Offense module, complete the necessary fields to add
a record.
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Master Name

As discussed in Involved Parties, all name information is stored in the Master
Name table, regardless of the module it was entered in. This provides a quick
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method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Warnings
As discussed in Involved Parties, should hazardous information be associated
with the individual, the user is presented with this information as a warning.
Refer to Involved Parties for more information.

Addr/Emp History

Once an individual's name has been entered, if any existing data is found we
have seen how it can populate fields to reduce keystrokes. In addition,
previous addresses and employment history is also associated with the
individual. The user can click on the Addr/Emp History button and be
presented with a grid of each occurrence.
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Master Vehicle

As discussed in Involved Parties, all vehicle information is stored in the Master
Vehicle table, regardless of the module it was entered in. This provides a
quick method for checking against existing records to eliminate duplicate files,
popuiate fields with existing data to reduce keystrokes and check for
wamings. Refer to Involved Parties for more information.

Master Location

As discussed in Calls For Service, all location information is stored in the
Master Location table, regardless of the module it was entered in. This
provides a quick method for checking against existing records to eliminate
duplicate files, populate fields with existing data to reduce keystrokes and
check for warnings. Refer to Calls For Service or Master Location Module for
more information.
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Grids

Throughout the Suspect module, various grids are utilized to capture data.
The grids within Suspect are the Aliases and Scars/Marks/Tattoos/Clothing
sections. Refer to Involved Parties for more information on entry and removal.

Images and Mugshots

As discussed in Involved Parties, various images can be stored within the
Suspect module. Refer to Involved Parties for more information.

Required Fields
The Suspect module has required fields that must be completed before the Add
process can be finalized. These include:

AGENCY (Alphanumeric, System-supplied)
REPORT NUMBER (Alphanumeric)
SUFFIX (Numeric)

SUSPECT # (Numeric)

LAST NAME (Alphanumeric)

Don't worry if a required field is forgotten. The system will display a message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the field needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.

Additionally, the LOCKED? and JUVENILE? fields in the upper right corner allow the
user to limit access to the report. If checked, only users authorized to view locked
and/or juvenile records will be able to view and/or access the report. The locked
feature is primarily used when the offense being reported is of a sensitive nature or
involves agency personnel. The juvenile feature keeps juvenile records private per
federal mandates.

During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fieids (the ones
that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-clicking
with the mouse. Refer back to Special Data Fields for more information.

When all the data has been entered into each respective tab, use the Add function
button to add the report to the database. It is not necessary to use the Add function
button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. Once
complete, use the xReturn function button to return to the ariginal Offense report. A
summary of the suspect information should now be displayed under tab #8.
Suspect/Arrest. Now we can move onto the next linked module, Property.
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Options Menu

The Suspect module offers various options for interacting with data. Such options
include viewing associated data or clearing certain fields to facilitate entry of cloned
records. These features are found in the Options menu.

View Reject Notes
Any notes attached to a rejection from the Workfiow process are viewable
from this selection.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological list of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Offense
The View Offense option permits the operator to view the related Offense
information of the displayed record.

View Record Information

The View Record Information option permits the operator to view the original
incident record entry. This differs from the View Audit Trail option in that any
records that have not be updated are not available in the Audit Trail. Thus to
view these unabridged incidents, the View Record Information is provided.

Clear Name Info

The Clear Name Info option clears all Master Name information from the
current record, including address, military and employment information as well
as any associated aliases or scars, marks or tattoos.

Clear Veh Info
This Clear Veh Info option clears all Master Vehicle information from the
current record.

Set Default Values

The Set Default Values option toggles whether the values associated with the
City, State, and/or Zip Code that were entered into the Admin Table for the
Agency's personal information are entered as defaults. This eliminates having
to enter these values for addresses that fall within the same geographical area
as the agency's address.

Printing Records
The Suspect module allows the user to print the displayed screen or the entire report.
These features, shown beiow, are accessed from the File option of the menu bar.

Print Screen
The Print Screen option permits the operator to print the currently displayed
screen.
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Print Suspect Report
The Print Suspect Report menu option permits the operator to print the entire
Suspect report of the currently displayed record.

Print List of Candidates

The List of Candidates from a search can be printed into a hard-copy list.
From the List of Candidates display, select the File option from the menu bar
and then select the desired print option.
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PROPERTY

The Property module captures and displays data about property entered into the system.
Property can include stolen property, recovered property, evidence, etc. Property does not
include vehicles. Vehicles is such a large grouping, ICIS offers Vehicles as its own module.

Adding a Property Report

Upon accessing the Property module, the cursor is placed in the Report/Ref # field.
This is where entry begins. Notice that the screen has two parts: the top contains the
key fields regarding the property’s location within the system; and below this are the
tabbed sections. The key fields remain constant within the display while the tabbed
sections change based on which section is being displayed.
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The Property module contains five sections: Main; Owner Information;
Recovery/History; Narrative/NCIC; and Workflow. The Main tab, as shown above,
contains the data pertaining fo the date, time and value of the piece of property, theft
information, offense and UCR information, other related property fields and drug
information if the property is in fact a controlled substance.

On the main tab is a “Search Bike/Pawn” button, this allows you to cross check the
property in the Pawn Module and the Bike Registration Module,
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The Owner Information tab contains data about the owner(s) of the property.
Pressing F4 function key while in the Last Name field will display a list of all people
entered throughout the system under the current report number. If a name is
selected from this list, name, address and phone information from the selected
individual will be placed in the corresponding owner fields.
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The Recovery/History tab contains data related to the recovery, damaged values and

history of the property and uses a grid format, which provides a useful chain of
custody chart.
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The Narrative/NCIC tab contains information on the submission of the record to
NCIC, as well as narrative associated with the Property record. The narrative portion
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also offers a spell-checking feature. Just like in the Offense module, complete the
necessary fields to add a record.
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The Workflow tab offers the ability for the responsible parties to sign off on the report.
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Master Name

As discussed in Involved Parties, all name information is stored in the Master
Name table, regardless of the moduie it was entered in. This provides a quick
method for checking against existing records to eliminate duplicate files,
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populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Master Vehicle

As discussed in Involved Parties, all vehicle information is stored in the Master
Vehicle table, regardless of the module it was entered in. This provides a
quick method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Master Location

As discussed in Calls For Service, all location information is stored in the
Master Location table, regardless of the module it was entered in. This
provides a quick method for checking against existing records to eliminate
duplicate files, populate fields with existing data to reduce keystrokes and
check for warnings. Refer to Calls For Service or Master Location Module for
more information.

Images and Mugshots

As discussed in Involved Parties, various images can be stored within the
Property module. Refer to involved Parties for more information,

Required Fields
The Property module has required fields that must be completed before the Add
process can be finalized. These include:

AGENCY (Alphanumeric, System-supplied)
REPORT/REF # (Alphanumeric)

SUFFIX (Numeric)

REC # (Numeric)

REC TYPE (Coded)

PROPERTY TYPE (Coded)

Don't worry if a required field is forgotten. The system will display 2 message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the field needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.

Additionally, the LOCKED? and JUVENILE? fields in the upper right corner allow the
user to limit access to the report. if checked, only users authorized to view locked
and/or juvenile records will be able to view and/or access the report. The locked
feature is primarily used when the offense being reported is of a sensitive nature or
involves agency personnel. The juvenile feature keeps juvenile records private per
federal mandates.

During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fields (the ones
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that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-clicking
with the mouse. Refer back to Special Data Fields for more information.

When all the data has been entered into each respective tab, use the Add function
button to add the report to the database. It is not necessary to use the Add function
button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. Once
complete, use the xReturn function button to return to the original Offense report. A
summary of the property information shouid now be displayed under tab #6.
Property/Vehicle. Now we can move onto the next linked module, Vehicle.

Options Menu

The Property module offers various options for interacting with data. Such options
include viewing associated data. These features are found in the Options menu.

View Reject Notes
Any notes attached to a rejection from the Workflow process are viewable
from this selection.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological list of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Offense
The View Offense option permits the operator to view the related Offense
information of the displayed record.

View Record Information

The View Record Information option permits the operator to view the original
incident record entry. This differs from the View Audit Trail option in that any
records that have not be updated are not available in the Audit Trail. Thus to
view these unabridged incidents, the View Record Information is provided.

Set Default Values

The Set Default Values option toggles whether the values associated with the
City, State, and/or Zip Code that were entered into the Admin Table for the
Agency's personal information are entered as defaults. This eliminates having
to enter these values for addresses that fall within the same geographical area
as the agency's address.

Printing Records
The Property module allows the user to print the displayed screen or the entire report.
These features, shown below, are accessed from the File option of the menu bar.

Print Screen
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The Print Screen option permits the operator to print the currently displayed
screen,

Print Property Report
The Print Property Report menu option permits the operator to print the entire
property report of the currently displayed record.

Print List of Candidates

The List of Candidates from a search can be printed into a hard-copy list.
From the List of Candidates display, select the File option from the menu bar
and then select the desired print option.
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VEHICLE

The Vehicle module captures and displays data about vehicles entered into the system.
Vehicles can be associated with victims, suspects, witnesses, passengers, etc.

Adding a Vehicle Report

Upon accessing the Vehicle module, the cursor is placed in the Report Number field.
This is where entry begins. Notice that the screen has two parts: the top contains the
key fields regarding the vehicle's location within the system; and below this are the
tabbed sections. The key fields remain constant within the display while the tabbed
sections change based on which section is being displayed.
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The Vehicle module contains five sections: Main; Owner Information; Narrative/NCIC;
Accident/Towing; and Workflow. The Main tab, as shown above, contains the data
pertaining to the date, time and value of the vehicle, theft information, offense and
UCR information, other related vehicle fields.
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The Owner Information tab contains data about the owner{s) of the vehicle. Pressing
F4 function key while in the Last Name field will display a list of all people entered
throughout the system under the current report number. If a name is selected from
this list, name, address and phone information from the selected individual will be
placed in the corresponding owner fields.
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The Narrative/NCIC tab contains information on the submission of the record to
NCIC, as well as narrative associated with the Vehicle record. The narrative portion
also offers a spell-checking feature.
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The Accident/Towing tab allows entry for towing and accident information, as well as
vehicle contents. Pressing the F3 function key while in the Policyholder Name field
will place the name of the Primary Owner in this field. Just like in the Offense
module, complete the necessary fields to add a record.
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The Workflow tab offers the ability for the responsible parties to sign off on the report.
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Master Name

As discussed in Involved Parties, all name information is stored in the Master
Name table, regardless of the module it was entered in. This provides a quick
method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Master Vehicle

As discussed in Involved Parties, all vehicle information is stored in the Master
Vehicle table, regardless of the module it was entered in. This provides a
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quick method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Master Location

As discussed in Calls For Service, all location information is stored in the
Master Location table, regardless of the module it was entered in. This
provides a quick method for checking against existing records to eliminate
duplicate files, populate fields with existing data to reduce keystrokes and
check for warnings. Refer to Calls For Service or Master Location Module for
more information.

Images and Mugshots

As discussed in Involved Parties, various images can be stored within the
Vehicle module. Refer to Involved Parties for more information.

Required Fields

The Vehicle module has required fields that must be completed before the Add
process can be finalized. These include:

AGENCY (Alphanumeric, System-supplied)
REPORT NUMBER (Alphanumeric)
SUFFIX (Numeric)

REC # (Numeric)

RECORD TYPE (Coded)

VIN (Alphanumeric)

DATE REPORTED (MMDDYYYY)

Don't worry if a required field is forgotten. The system will display a message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the field needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.

Additionally, the LOCKED? and JUVENILE? fields in the upper right corner allow the
user to limit access fo the report. If checked, only users authorized to view locked
and/or juvenile records will be able to view and/or access the report. The locked
feature is primarily used when the offense being reported is of a sensitive nature or
invoives agency personnel. The juvenile feature keeps juvenile records private per
federal mandates.

During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fields (the ones
that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-ciicking
with the mouse. Refer back to Special Data Fields for more information.

When all the data has been entered into each respective tab, use the Add function
button to add the report to the database. It is not necessary to use the Add function
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button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. Once
complete, use the xReturn function button to return to the original Offense report. A
summary of the vehicle information should now be displayed under tab #6.
Property/Vehicle. Now we can move onto the next linked module, Citations.

Options Menu

The Vehicle module offers various options for interacting with data. Such options
include viewing associated data or clearing certain fields to facilitate entry of cloned
records. These features are found in the Options menu.

View Reject Notes
Any notes attached to a rejection from the Workflow process are viewable
from this selection.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological list of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Offense
The View Offense option permits the operator to view the related Offense
information of the displayed record.

View Record Information

The View Record Information option permits the operator to view the original
incident record entry. This differs from the View Audit Trail option in that any
records that have not be updated are not available in the Audit Trail. Thus to
view these unabridged incidents, the View Record Information is provided.

Clear Veh Info
This Clear Veh Info option ciears all Master Vehicle information from the
current record.

Set Default Values

The Set Default Values option toggles whether the values associated with the
City, State, and/or Zip Code that were entered into the Admin Table for the
Agency’s personal information are entered as defaults. This eliminates having
to enter these values for addresses that fall within the same geographical area
as the agency's address.

Printing Records
The Vehicle module allows the user to print the displayed screen or the entire report.
These features, shown below, are accessed from the File option of the menu bar.

Print Screen
The Print Screen option permits the operator to print the currently displayed
screen.

PSSt
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Print Vehicle Report
The Print Vehicle Report menu option permits the operator to print the entire
vehicle report of the currently displayed record.

Print List of Candidates

The List of Candidates from a search can be printed into a hard-copy list.
From the List of Candidates display, select the File option from the menu bar
and then select the desired print option.
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CITATIONS

The Citations module captures and displays data about citations issued by the agency.
Citations can include traffic, civil, criminal etc.

Adding a Citations Report

Upon accessing the Citations module, the cursor is placed in the Citation # field. This
is where entry begins, Notice that the screen has two parts: the top contains the key
fields regardlng the citation's basic data; and below this are the tabbed sections. The
key fields remain constant within the display while the tabbed sections change based
on which section is being displayed.
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The Citations module contains seven sections: Main; Vehicle; Citation Info;
Violations, Court/Narrative; Emp/Military; and Workflow. The Main tab, as shown
above, contains the Master Name information for the cited individual, as well as

address information.

“pssi’

Public Sofety Systems tntorparoted

75



ICIS Records Management System

The Vehicle tab allows for the entry of vehicle data. The COPY DRIVER button in the

Vehicle Owner section will populate the appropriate fields should the driver also be
the vehicle owner and their data has been completed within Tab #1.
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The Citation Info tab contains information on the location and circumstances related
O to the citation.

Eﬂ'_m = .h -.1.-'

- '.".'_:_"L{Emm] ]o‘m F'-‘"'r.nwmv I Locked ? J

T i TR 3CAsioniets | 4 Vieletions Y SComtiamative | EEmpobiitay T Lwerkton
m
Shit  RepestDit  Boat CA
_raw | ] f
EAe Strast WSS Shest ral g Agoncy Axugned
A - __Ld = ]
l—dlp Ilm.llpﬂ.-l
f : [ Wa'#{'* -Tﬁ"f*&‘h"ﬂnjl
Ercimstncen: -
Aparte, Spoed Posled Sperd . Saip Gpesd Wathod Used Flada (D D of Travel Lane B
[ T L el R | [ ]
Ligght Wasthost | ComeVeh Haz Mst Sehenl Zone Bookmg Ang
I | ko= sl Jl il
Difeer Prassnt Posgeesed DL : Accidant # Sull Aolsted Olfanas
[ Jsl__ } o Je [ E - | j
By Hy Nama R d By Frewierwstal By Moammg
I e e B | T ]
prevow | gowen [ e | dod | s | peeie | gee | e |
|
L
7 PSS

Public Saiety Systams Incorpacated



ICIS Records Management System

= The Violations tab contains information on the violations cited, any additional
violations and Search and Results information.

= I Tooktal

o4

m"“—':" ;t:ﬁ u F_lh-- ’P"r .|W|lll|l7 . T Lockad 7

] j,\l'm!aﬁnn-Snnrdnl'l ECGIINNNIM'NO] E,Empmmlmy | FWmH w
Sanichas and Results

Additional Viglubons

Elli_jibln o1 Dismissal
Psasnn Far Stop. Source

a spell-checking feature.

I Drugs/Alcoha/Paraphernalia Found
™ Wenpon Found

[~ Stalen Property Found

™ Othmr Contraband Found

piets | geer | w |

The Court/Narrative tab contains information concerning court appearance and as
well as narrative associated with the Citation record. The narrative portion also offers
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=" The Emp/Military tab contains information about the individual's employment as well

as military status. Just fike in the Offense module, complete the necessary fields to
add a record.
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Retrieve Arrest

With the use of the Retrieve Arrest option from the File menu, data entry can
be reduced by utilizing information from the existing Arrest record to begin the
Citation record. To use the Retrieve Arrest function, at least one of the
following fields must be filled in: Citation Number, Name, Race, Sex and/or
DOB. Wildcards may be used in the Citation Number field, as well as in all
Name fields. In addition, a soundex option is available for searches involving
a Last Name. Once alt of the search information has been entered, select the
Retrieve Arrest option from the File menu. If a matching Arrest record is
found, the Master Name, Master Vehicle, Body Marking, Alias, Charge and
Arrest information from the Arrest record will be brought into the Citation
record. 1f more than one matching Arrest record is found, a list of candidates
will be displayed from which the operator may select the exact record to use
for bringing the Arrest data forward.

Retrieve Inv Party

With the use of the Retrieve Inv Party option from the File menu, data entry
can be reduced by utilizing information from the existing Involved Party record
to begin the Citation record. To use the Retrieve Inv Party function, at least
one of the following fields must be filled in: Citation Number, Name, Race, Sex
and/or DOB. Wildcards may be used in the Citation Number field, as well as
in all Name fields. In addition, a soundex option is available for searches
involving a Last Name. Once ali of the search information has been entered,
select the Retrieve Inv Party option from the File menu. If a matching
Involved Party record is found, the Master Name, Master Vehicle, Body
Marking, and Alias information from the Involved Party record will be brought
into the Citation record. If more than one matching Involved Party record is
found, a list of candidates will be displayed from which the operator may
select the exact record to use for bringing the involved Party data forward.

Master Name

As discussed in Involved Parties, all name information is stored in the Master
Name table, regardless of the module it was entered in. This provides a quick
method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.

Warnings
As discussed in Involved Parties, should hazardous information be associated
with the individual, the user is presented with this information as a warning.
Refer to Involved Parties for more information.

Master Vehicle

As discussed in Involved Parties, all vehicle information is stored in the Master
Vehicle table, regardless of the module it was entered in. This provides a
quick method for checking against existing records to eliminate duplicate files,
populate fields with existing data to reduce keystrokes and check for
warnings. Refer to Involved Parties for more information.
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Master Location

As discussed in Calls For Service, all location information is stored in the
Master Location table, regardless of the module it was entered in. This
provides a quick method for checking against existing records to eliminate
duplicate files, populate fields with existing data to reduce keystrokes and
check for warnings. Refer to Cails For Service or Master Location Module for
more information.

Grids
Throughout the Citations module, the Primary Violations grid is utilized to
caplure data. Refer to Involved Parties for more information on entry and
removal.

Images and Mugshots

As discussed in Involved Parties, various images can be stored within the
Citations module. Refer to Involved Parties for more information.

Required Fields

The Citations module has required fieids that must be completed before the Add
process can be finalized. These include:

AGENCY (Alphanumeric, System-supplied)
CITATION # (Numeric)

SUFFIX (Alphanumeric)

ISSUED DATE (MMDDYYYY)

TIME (HHMM)

LAST NAME (Alphanumeric)

VIOLATION (Coded)

TYPE (Coded)

Don't worry if a required field is forgotten. The system will display a message at the
top of the screen highlighted in red warning of the omission and will move your cursor
to the field needing attention. As you perform daily entries, you will begin to
recognize required fields immediately.

Additionally, the LOCKED? and JUVENILE? fields in the upper right corner allow the
user to limit access to the report. If checked, only users authorized to view locked
and/or juvenile records will be able to view and/or access the report. The locked
feature is primarily used when the offense being reported is of a sensitive nature or
involves agency personnel. The juvenile feature keeps juvenile records private per
federal mandates.

During data entry, moving from field to field is accessed by either the TAB key to go
forward one field, the SHIFT-TAB combo to move back one field or the mouse to click
on the desired field in any order. Also, don't forget about the coded fields (the ones
that look 3-D). They contain codes your agency uses for consistent, uniform data
entry throughout the system. They are accessed by the F2 key or by double-clicking
with the mouse. Refer back to Special Data Fields for more information.
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When all the data has been entered into each respective tab, use the Add function
button to add the report to the database. It is not necessary to use the Add function
button from each tab, but it is a good idea. At the top of the screen, a green
confirmation message is displayed to indicate the process was accepted. Once
complete, use the xReturn function button to return to the original Offense report. A
summary of the citation information should now be displayed under tab #9. Citations.
Now we can move onto the next linked module, Case Management.

Options Menu

The Citations module offers various options for interacting with data. Such options
include viewing associated data or clearing certain fields to facilitate entry of cloned
records. These features are found in the Options menu.

View Reject Notes
Any notes attached to a rejection from the Workflow process are viewable

from this selection.

View Audit Trail

The View Audit Trail option permits the operator to view a chronological fist of
record changes. The changes include who performed and last updated the
record, along with the dates and times associated with update.

View Record Information

The View Record Information option permits the operator to view the original
incident record entry. This differs from the View Audit Trail option in that any
records that have not be updated are not available in the Audit Trail. Thus to
view these unabridged incidents, the View Record Information is provided.

Clear Name Info

The Clear Name Info option clears all Master Name information from the
current record, including address, military and employment information as well
as any associated aliases or scars, marks or tattoos.

Clear Veh Info
This Clear Veh Info option clears all Master Vehicle information from the
current record.

Set Default Values

The Set Default Values option toggles whether the values associated with the
City, State, and/or Zip Code that were entered into the Admin Table for the
Agency's personal information are entered as defaults. This eliminates having
to enter these values for addresses that fall within the same geographical area
as the agency's address.

PSST
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Printing Records

The Citations module allows the user to print the displayed screen or the entire
report. These features, shown below, are accessed from the File option of the menu

bar.

Print Screen
The Print Screen option permits the Operator to print the currently displayed
screen,

Print Citation Report
The Print Citation Report menu option permits the operator to print the entire
citation report of the currently displayed record.

Print List of Candidates

The List of Candidates from a search can be printed into a hard-copy list.
From the List of Candidates display, select the File option from the menu bar
and then select the desired print option,
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CASE MANAGEMENT

The Case Management module captures and displays data about the assignments and
progression of the case itseif.

Adding a Case Management Report

Upon accessing the Case Management module, the cursor is placed in the Incident
Number field. This is where entry begins. Notice that the screen has two parts: the
top contains the key fields regarding the case's location in the system; and below this
are the tabbed sections. The key fields remain constant within the display while the
tabbed sections change based on which section is being displayed.
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The Case Management module contains six sections: Main; Solvability,
Victim/Witness; Case History; Activity and Narrative. The Main tab, as shown above,
contains the overall information about the case. In addition, this tab offers a link to
the Offense module to view the complete offense record associated with the case
management record without having to exit the Case Management module.
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The Solvability tab contains information about the Investigator assigned, Supervisor
and the solvability factors based on gathered facts about the case. The solvability
factors and scores are user generated through code table maintenance. While
investigating a crime, the user will select the appropriate factors to receive a total
score. This will assist in determining the probability of solving the case.
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The Victim/Witness tab contains summary information about these individuals with a
direct link to the Involved Parties module and their individual records. Simply double-
click on the individual record and the record is displayed as though accessing it from
the Involved Parties module.
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